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TRADEMARKS AND COPYRIGHT 

 
Trademarks 
 

� Microsoft Windows, Windows NT, and the brand names and other product names 
of other Microsoft products are trademarks of Microsoft Corporation in the United 
States and/or other countries. 

� All other product names and logos are trade and service marks of their respective 
companies. 

 

Copyright 
 
Copyright © 2006-2007 TOSHIBA TEC CORPORATION All rights reserved  

The information contained in this document is the property of Toshiba (Australia) Pty 
Limited. 

Neither receipt nor possession hereof confers or transfers any right to reproduce or 
disclose whole or any part of the contents hereof, without the prior written consent of 
Toshiba (Australia) Pty Limited. 

 

Disclaimer 

 
The following notice sets out the exclusions and limitations of liability of TOSHIBA TEC 
CORPORATION (including its employees, agents and sub-contractors) to any purchaser 
or user (‘User’) of the e-BRIDGE Job Build, including its accessories, options and bundled 
software (‘Product’). 
 
1. The exclusion and limitations of liability referred to in this notice shall be effective to the 
fullest extent permissible at law. For the avoidance of doubt, nothing in this notice shall be 
taken to exclude or limit TOSHIBA TEC CORPORATION’s liability for death or personal 
injury caused by TOSHIBA TEC CORPORATION’s negligence or TOSHIBA TEC 
CORPORATION‘s fraudulent misrepresentation. 
 
2. All warranties, conditions and other terms implied by law are, to the fullest extent 
permitted by law, excluded and no such implied warranties are given or apply in relation to 
the Products. 
 
3. TOSHIBA TEC CORPORATION shall not be liable for any loss, cost, expense, claim or 
dam-age whatsoever caused by any of the following: 
(a)use or handling of the Product otherwise than in accordance with the manuals, 
including but not limited to Operator’s Manual, User‘s Guide, and/or incorrect or careless 
handling or use of the Product; 
(b)any cause which prevents the Product from operating or functioning correctly which 
arises from or is attributable to either acts, omissions, events or accidents beyond the 
reasonable control of TOSHIBA TEC CORPORATION including without limitation acts of 
God, war, riot, civil commotion, malicious or deliberate damage, fire, flood, or storm, 
natural calamity, earthquakes, abnormal voltage or other disasters; 
(c)additions, modifications, disassembly, transportation, or repairs by any person other 
than service technicians authorized by TOSHIBA TEC CORPORATION; or 
(d)use of paper, supplies or parts other than those recommended by TOSHIBA TEC 
CORPORATION. 
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4. Subject to paragraph 1, TOSHIBA TEC CORPORATION shall not be liable to Customer 
for: 
(a)loss of profits; loss of sales or turnover; loss of or damage to reputation; loss of 
production; loss of anticipated savings; loss of goodwill or business opportunities; loss of 
customers; loss of, or loss of use of, any software or data; loss under or in relation to any 
contract; or 
(b)any special, incidental, consequential or indirect loss or damage, costs, expenses, 
financial loss or claims for consequential compensation; 
 
whatsoever and howsoever caused which arise out of or in connection with the Product or 
the use or handling of the Product even if TOSHIBA TEC CORPORATION is advised of 
the possibility of such damages. 
 
TOSHIBA TEC CORPORATION shall not be liable for any loss, cost, expense, claim or 
dam-age caused by any inability to use (including, but not limited to failure, malfunction, 
hang-up, virus infection or other problems) which arises from use of the Product with 
hardware, goods or software which TOSHIBA TEC CORPORATION has not directly or 
indirectly supplied 
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Introduction 
 

Toshiba e-BRIDGE Job Build is a software application that can create multiple sets of a 
document where the content and/or job settings vary throughout. It enables you to simply 
and easily combines multiple documents into one finished document. 

 

 

 

 

 

 

 

 

Multiple copies of the 
constructed document 
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System Requirements 
 

Installation and configuration of this software should only be conducted by a person who 
has the required skills and knowledge in the following areas: 
 

• Microsoft Windows 

• Adding/configuring a printer 
 
To install the e-BRIDGE Job Build printers on a Windows workstation, the following 
minimum specifications are required: 
 

• Display Resolution 
1024 x 768 dots or higher resolution monitor 

• Display Colour 
High Colour (16bit) or higher is recommended 

• CPU 
Pentium 266 MHz minimum or faster recommended 

• Memory 
128 megabytes (MB) of RAM or higher recommended 

 
Supported Operating Systems: 
 

• Windows XP Professional Service Pack 1 (32bit) 

• Windows XP Professional Service Pack 2 (32 bit) 

• Windows Vista Business Edition (32 bit) 

• Windows Vista Ultimate Edition (32 bit) 

 

 

Pre-requisites 
 

• Toshiba Multifunction Device.  
e-STUDIO MFD with print option (if not standard) utilising e-BRIDGEI/II architecture. 
(Check with Toshiba Representative for latest product compatibility.) 

 

• e-BRIDGE PostScript (PS3) print driver.  
The e-BRIDGE PostScript (PS3) print driver must be installed on a local port.    
(Toshiba e-BRIDGE Job Build will not function with shared printers, PCL5c and PCL6 
print drivers.)  
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Software Installation 
 

1. Double click ‘Setup.exe’.  

 

 

 

 

 

 

 

 

 

 

2. Click [Next >]. 
 
 

 

 

 



 - 8 - 

3. Read the License Agreement and select ‘I accept the terms in the license 
agreement’. Then click [Next >]. 

 
 

 

 

 

 

4. Fill in the User Name and Organization fields and then click [Next >]. 
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5. Click [Install]. 

 

 
 
 
6. The default name will appear “e-BRIDGE Job Build”. Please add the appropriate 

e-STUDIO model to the printer name and select the Toshiba e-STUDIO printer of 
your preference.  

 
By default, creating shortcuts on the ‘Desktop’ and in the ‘SendTo’ folder are 
unselected. Please select the desired shortcuts if any and then click [OK]. 

 

 

 

7. Click [OK]. 
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8. Installation is Complete. Click [Finish]. 
 

 
 

 

9. Deselect SNMP communication 
Make sure SNMP communication is disabled. This can be found in “Start”  
‘Printers and Faxes’ and then the Properties of the print driver, under the 
Configuration tab. 
 

 Note ! 
Failing to deselect SNMP communication will result in a long delay when selecting the 
Job Build printer for printing. 
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Additional Job Build Printers 
 

You may want to have additional e-BRIDGE Job Build printers for each Toshiba e-
STUDIO printers on your network. 
 
To add an additional e-BRIDGE Job Build driver, please complete the following steps: 
 

1. Go to the [Start] → [All Programs] → [TOSHIBA e-BRIDGE] → [Job Build] → 
[Add new Job Build Printer] 

 

 

 
 

2. The default name will appear “e-BRIDGE Job Build”. Please add the appropriate 
e-STUDIO model to the printer name and specify the Toshiba e-STUDIO printer of 
your preference then click [OK] 

 

 

 

3. Click [OK] 
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Interface Description 
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A – Job Build List 

This displays the list of jobs that have been added to an e-BRIDGE Job Build Print thus 
far. 
 

B – The selected print job 

This is the high-lighted print job. It is possible to select multiple jobs at a time by holding 
the CTRL or SHIFT button. 

 
C – Move Up 

Moves the selected print job higher up in the Job Build list. 
 

D – Move Down 

Moves the selected print job lower down in the Job Build list. 
 

E – Add More… 

Allows for more jobs to be added to the Job Build list for the selected e-BRIDGE Job 
Build Printer. 
 
When clicked, e-BRIDGE Job Build will close. The application will then reopen once a 
document is printed to that same e-BRIDGE Job Build Printer. 

 
F – Remove 

Removes the selected print job from the Job Build List. 
 

G – Number of Copies 

The number of copies of the resultant Job Build document to be printed. 
 
Number of copies can not be greater than 999. 
 

H – Process as a Single File 

Switches e-BRIDGE Job Build’s processing mode.  
 
By default, this option is unchecked and each job’s individual print settings will be 
maintained and respected when the documents are printed. The result is the same as if 
the user printed each job separately. 
 
Checking “Process as a Single File”, removes the print settings of each individual job so 
that the settings of the first job in the Job Build list, carries through to the rest. By 
selecting this option additional functionality has been provided such as continuous page 
numbering and saving the spool file. 
 

I – Enable Page Number (Available only if “Process as a Single File” is selected) 

Selecting this option enables continuous page numbering throughout all jobs in the order 
shown in the Job Build list. 
 

J – Output to Printer (Available only if “Process as a Single File” is selected) 
Determines whether the resultant job is sent to the Printer or not. 
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K – Output to File (Available only if “Process as a Single File” is selected) 

Saves a copy of the spooled file to the location displayed in “K”. 
 

L – Displays the filename for the “Output to File” option (Available only if “Output 

to File” is selected) 
This is an editable field that contains the name of the file to which the print file will be 
stored.  
 
The filename must be a valid full path. 
  

M – Browse (Available only if “Output to File” is selected) 

Brings up an explorer-like window to allow the user to choose the destination of the print 
file. 
 

N – Print 

Sends the jobs listed in the Job Build list to the printer with all the chosen options. 
 

O – Cancel 

Closes the e-BRIDGE Job Build application. 
 
All entries in the Job Build List will be removed. 
  

P – Help 
e-BRIDGE Job Build Help. 
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Using Job Build 
 
The following outline summarizes the steps for using job from any application.  
 

1. Open a desired document. 
2. Print to e-BRIDGE Job Build Driver. 
3. Select printer properties settings. 
4. Click “Add More…” 
5. Open next document 
6. Repeat steps 2 – 5 until all desired documents have been added. 
7. Reorganise the jobs in the list if needed. 
8. Modify e-BRIDGE Job Build Options if needed. 
9. Print the jobs from e-BRIDGE Job Build. 

 
 

Job Build via ‘drag and drop’ 

 

 
 
 
If a shortcut for the e-BRIDGE Job Build Printer has been added to the ‘Desktop’, the 
user can add jobs to e-BRIDGE Job Build by ‘drag and dropping’ the document onto the 
printer icon.   
 
This will work for all documents that have an associated application. 
 
 

Job Build via ‘sendTo’ 
 
 

 
 
 
If a shortcut for the e-BRIDGE Job Build Printer has been added to the ‘SendTo’, the user 
can add jobs to e-BRIDGE Job Build by right-clicking on the document and selecting 
‘SendTo’ followed by the e-BRIDGE Job Build Printer.  

 
This will work for all documents that have an associated application. 
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Job Build from Windows Applications 
 

1. Open a file and select [Print] from the [File] menu of the application.  
���� The Print dialog box appears. 

 
2. Select “e-BRIDGE Job Build” printer. 

���� Select the [Properties] button for general printer properties settings. 

 

 
 

3. Specify printer properties settings and click [OK]. 
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4. Click [OK] again to send the document to e-BRIDGE Job Build. 
���� e-BRIDGE Job Build will open 

 

 
 
 

5. Click [Add More…] 
���� e-BRIDGE Job Build will close 
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6. Print next document and click [Add More…] to add additional jobs. 
���� e-BRIDGE Job Build will reopen once the next job is printed 

 

 
 
 

7. Repeat Step 6 until all desired jobs have been added.  
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8. Reorganise the jobs if needed by selecting the jobs and clicking [Move Up] and 
[Move Down] 

 

 
 

9. Select the “Options” tab and modify as desired. 
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10. To select “Output to File”, first select “Process as a Single File”  
 
 

  
 
 
11. Select “Output to File”, and then click [Browse]. 
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12. Choose the destination and filename and click [Save] 
 

 
 
13. Once the Job List and Options have been set, click [Print]  
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Printer Finishing Options 
 

 

 

What happens to the Finishing Options 

e-BRIDGE Job Build handles the finishing options depending on which processing 
method has been selected by the user. The processing method is set by the "Process as 
a Single File" checkbox in the "Options" tab. 
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NOT selecting the option (Default) 
 
In this case, the finishing options of each job are maintained. The result at the printer is 
no different to printing each job separately with its own individual finishing options. 
 
Option selected 
 
The finishing options of the first job in the list are used to process all the remaining jobs. 
This refers to the first job in the list when the user clicks on "Print". 
 

Limitations with finishing options 

The following finishing options are not supported when "Process as a Single File" is 
selected.  

• Number of pages per sheet  
• Duplex with booklet mode  
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Frequently Asked Questions 
 

Q. I can not install e-BRIDGE Job Build. 
A.  

I. To install e-BRIDGE Job Build you need Administrator rights to your PC. 
Check user accounts in the Control Panel and confirm that you have 
administrative rights. 

II. Ensure Print Spooler is turned on 
III. On Vista, User Account Control must be turned off 

 

 

 

Q. The installation seems to be hung. 
A. Please check that the installer window is not hiding the Install Redirect Printer 

application. 

 

Q. After I select the Job Build printer it takes a long time for the print driver to appear. 
A. Make sure you have deselected SNMP communication (see page 10) 

 

Q. I am trying to add a new Job Build printer but the Toshiba MFD does not appear in 
the ‘Select a Toshiba Printer’ list.  

A. Make sure you have the PostScript (PSL3) driver installed and not the PCL driver. 
e-BRIDGE Job Build only works with a PostScript print driver. 
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Q. I am getting an “Error: Unable to add this printer. Please select another PostScript 
Printer”. 

A.  
I. Did you install the Toshiba MFD as a local printer or network printer?                   

e-BRIDGE Job Build can only be used with local printers.  
 

II. Please make sure the local printer installed is not shared.  
 
 

Q. The document icon does not appear in e-BRIDGE Job Build. 
A. Document icons will be displayed only if “Hide extensions for known file types” 

have been uncheck in the “Folder Options” of the windows explorer. 
  

 
 


